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Photoshop Elements: Improve Digital Images 
Center for Instructional Technology 
http://cit.jmu.edu/training 

 
About Photoshop Elements 
Photoshop Elements is an affordable digital image manipulation 
program made by Adobe. It is the "little brother" of Adobe 
Photoshop, a professional level program used by image editors all 
over the world. Photoshop is generally considered to be at the top 
of the heap when it comes to image editing, but also comes with a 
learning curve that can make it difficult for the casual user to really 
use it effectively, not to mention its 
$699 retail price. Photoshop Elements 

started as a way of making digital image manipulation affordable 
(retail price at $99.99). The straightforward interface of Photoshop 
Elements, moreover, often makes commonly used tasks easier to 
access than the full version of Photoshop. 
 
 
Digital Image Basics 

Before we can learn how to manipulate digital images, we first need 
to understand what they are. Every digital image is just a grid of tiny 
blocks of color called pixels. These pixels are the only unit of 
measurement that a computer can understand. Any other unit of 
measurement has to be translated to exactly how many pixels are in 
a single unit. This is called resolution. Most of the time we talk 
about resolution in terms of pixels per inch or ppi (dots per inch or 
dpi can be used interchangeably). Resolution is a concept that is 
often mistaken for a measure of quality in digital photography. While 
low resolutions can limit quality, it is by no means the only measure. 
Also, resolution is really only applicable to printed images. All 
images seen on screen are considered to be 72 ppi. For printing, 

300 pixels per inch is considered the standard for achieving photographic quality. 
 
In order to use resolution effectively you need to do a little math. The chart below can be used 
for reference. 
 
Megapixels Image 

Dimensions 
Total Pixels Display at 72 

dpi 
Display at 300 

dpi 
.3 640 x 480 307,200 8 in x 6.6 in 2.1 x 1.6 

1.8 1600 x 1200 1,920,000 22.2 in x 16.6 in 5.3 in x 4 in 
4.2 2400 x 1800 4,320,000 33.3 in x 25 in 8 in x 6 in 
7.5 3200 x 2400 7, 680,000 44. in x 33.3 in 10.6 in x 8 in 

 
 
We will use Photoshop Elements (PSE) to manipulate these pixels. In most cases, we will want 
to try and avoid having PSE add pixels to the image as this will decrease the visual quality of 
the image (though sometimes this is unavoidable). Having PSE subtract pixels is usually not 
very harmful to the visual quality, as long as this doesn't cause the image to stretch.  

 
 
 
 
 
 
 
 
 
 
This close-up shows the 
pixels that make up this 
image. 
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Workspace 
 

 
 
If you haven't already, open Photoshop Elements. You will find yourself faced with the work 
area pictured above. There are six main components that we will look at today. 
 
1. Menu Items  

 
The Menu Items are commands that either affect selected areas of your image or activate 
hidden tools. We will not go through every menu command in this workshop, but you are 
encouraged to go through the menu commands and experiment with the options.  
 
Take particular note that many of the commands have a keyboard shortcut that will enact that 
menu option immediately. For example, Ctrl+S is relates to the Save function, meaning that 
holding down the Ctrl key on your keyboard and simultaneously pressing the S key will save 
your document. Menu Items of interest:  
 
 File/Open - You'll note that many menu commands are not available until you use this 

command to open an image. 
 File/New - You can also create an empty canvas to compose a new image from scratch. 

Try something about 500 x 500 pixels if you want to experiment. 
 Window - If you can not find a palette, there is a list of all of them under this menu. A 

check mark means it's already visible on the screen, so clicking it again will make it 
disappear. 

1. Menu Items 
2. Shortcut Menu 

3. Options Bar 

4. Tool Bar 

5. Floating Palette 

6. Docked 
Palette 
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 Enhance - The Enhance menu contains a number of tools for making digital photos look 
better. This is a big advantage over the maze of menus necessary to complete the same 
tasks in the full version of Photoshop. We will be looking closely at some of these menu 
items via hands-on activities. 

 Edit/Preferences - You can reset most of the defaults here, so if you find yourself 
changing a particular option over and over again, this can help. Unlike most areas of 
Photoshop (where we encourage experimentation), if you don't understand what a 
preference does, it may be best to leave it alone. However, a re-install will likely fix any 
mishaps. 

 Edit/Undo - Everyone makes mistakes. Undo makes it as if your mistakes never 
happened. 

 
 
2.  Shortcut Menu 

 
The Shortcut Menu contains shortcuts to commonly used items that can be found in the Menu 

Items. Most of the time, the workshop will refer to the menu item to complete a command, but 
if the command exists in the shortcut bar, please feel free to use that as well. Also, if you 
don't know what a shortcut button does, just hold your mouse over the button for a second 
and a tag will appear telling you the name of the button. 

 
 
3.  Options Bar 
 
The Options bar will look different depending on what tool you have selected in the Tool Bar. 

The vast majority of the options for any tool will be found here, and we will cover the most 
important ones. Feel free to experiment in order to learn the rest. 

 
4.  Tool Bar  
  
Tools found here are used by clicking on the tool to select it, and the clicking and dragging on 
the canvas to actually use the tool. They are most frequently used to improve digital images. 
Any tool with a triangle in the lower right corner will reveal variations on that tool if you click and 
hold or right click on it. When the mouse cursor is hovered over a tool, a tag will appear to show 
you the name of the tool. Most of the tags can also link to the explanation of the tool. These 
tools will be explained in details in the "Exploring the Tools" section. 
 
5.  Floating Palettes 
 
Palettes are where you will find all manner of information and 

options for changing how different elements of your image 
interact with each other. You can also find tools that are 
enacted as a whole on an image instead of by clicking and 
dragging directly on the image. Palettes can be moved 
anywhere on the screen or closed all together. By default, 
some are floating and some are docked.  
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6.  Docked Palettes 
 
Docked Palettes are the same as Floating Palettes, but have been put up in the palette dock to 

de-clutter the screen. By default, Elements opens the Effects and Layers palettes at the 
docking station. All of the palettes can be opened under Window menu. You can also click 
and drag on the name of the palette to pull it out of the dock and turn it into a Floating Palette. 
Of the ones that are docked, the most useful are:  
 Effects - Special effects that can be applied to an image. When used, they can make an 

image look like a sketch, or being seen through rippled glass. Effects generally are 
applied to a whole image. 

 Layers - One of the most powerful features of both Photoshop and Photoshop Elements, 
the Layers palette allows you to control the order and interactions between layers. We 
will discuss layers at length in the Layers section. 

 
 
File Menu Options 
  
Before we take a look at each tool in the tool bar, 
we'll need some space to experiment with the tools. 
So let's open up a new blank image and get familiar 
with the File menu options. 
  
 Click on the File menu and choose New/Blank File... 
(The three dots "…" following Blank File means that 

the command will be followed by a pop-up dialog 
box where you can choose options from additional 
settings. This applies to all the menu commands in 
PSE.) 

 
Follow the direction above and click OK. This will give 
you a nicely sized white area (Canvas) for you to 
experiment with the tools. Some tools are made for 
opening photos though (They are grayed out in the 
background screenshot since no file is opening), so 
let's open up a photo. 
  
Click on the File menu and choose Open... and find 
the research.jpg file on your desktop. Double click on 
it to open it. This time you may find more options 
active in File menu than when there were no files 
already open in the work space. 
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Exploring the Tools 
 

The Move Tool is used to move elements from one area to another. This is mostly used 
in conjunction with the selection tool. You can also drag items from one image to 

another. Try selecting an area with one of the selection tools in research.jpg, and then use the 
move tool drag that selection to the empty white canvas. Holding down the Ctrl key always 
shortcuts to the tool. 
 
Note: When you hover over a tool, a tool tag will appear right below the selected tool. The 
keyboard shortcut of the tool ("V" in this case) and a link will lead you to the help tips for the 
particular tool. 
 

 
Click on your image using the Zoom Tool to zoom in one level. This tool doesn't alter the 
image. It just enables how close or far away we are to or from the image. Hold down the 

Alt key while clicking to zoom will enable you to back out from the image. There are also several 
zoom presets under the View Menu. 
 
 

The Hand Tool is basically an alternative to the scroll bars. If your image is bigger than 
your window, you can use the hand tool to move around instead of the scroll bars. To 
see it in action, zoom in using the Zoom Tool first. 

 
 

The Eyedropper Tool takes whatever pixel is clicked on, measures the color there, and 
makes that color the foreground color (See Color Chips later in the tutorial). 
 

 
The Marquee Tools are used to create selections. Do 
this by clicking and dragging. Selections are a way of 
telling PSE that you want to act only on one particular 
area of the image. Outside the selection, commands 

are ignored and tools are ineffective. The default shape is the rectangle. Click and hold in the 
toolbar to find circular (elliptical) shapes. Selected pixels can be erased from the image by 
pressing the Backspace key on your keyboard. 
 
 

The Lasso Tool allows you to create free form selections in 
any shape. Just click and drag your shape, but make sure it 
is a closed shape (double-click to automatically close your 
shape). Click and hold in the toolbar to find the Polygonal 
Lasso Tool, which lets you create shapes by single-

clicking points, or the Magnetic Lasso Tool, which allows you to create more defined 
selections. Selection lines are drawn in between your shapes. Make sure you have at least 
three sides. 
 
 

The Magic Wand Tool makes selections using math. When you click on a pixel with this 
tool, PSE looks at the all the surrounding pixels to see if they are roughly the same color. 
If they are, then PSE selects those pixels and compares all of its surrounding pixels to 

see if they are the same color (roughly) as the original pixel. The result is that areas that would 
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be extremely difficult to select otherwise are easily selected if they are roughly the same color. 
You can adjust how roughly the tool makes its decisions by changing the tolerance which is 
found in the options bar. 0 will select only that pixel and 255 will select every pixel in the image.  
 

 
The Quick Selection Tool will create selections in a 
more natural way than the other tools. Click and drag to 
create an area of selection. This tool is much more 
effective for selecting elements in photos than the other 

selection tools. Use the Selection Brush Tool to make brush-like selections in an image. In the 
Options Bar you can adjust the size and shape of your selection just as you can with other 
brush tools. Pay special attention to the hardness option. Bringing the hardness of your 
selection down can make cut outs look far more realistic. 
 
 

The Type Tools are used to add text to the image. Just choose 
the tool and click to create a text area. Font, size, color and 
more can be altered once again using the Options Bar. Clicking 
and holding in the toolbar reveals the ability to have vertical text 
as well as the ability to create selections in the shape of text. 
 

 
The Crop Tool is used to discard excess image areas. Click and drag to frame the part 
of the image you want to keep. Use the little square handles to resize. Click the check 

mark in the Options Bar to discard everything outside the crop. You can also press Return on 
the keyboard. Esc will cancel the crop. 
 
 

The Cookie Cutter Tool let's you cut out parts of your image in a particular shape. The 
shape can be changed in the Options Bar.  

 
 

The Straighten Tool is used to straighten a skewed image that is resulted from digital 
capture or scanning in an inappropriate angle. It has to be used with appropriate 
selection of the tool options, though. 

 
 
The Red Eye Removal Tool allows you to select an area in the picture where there is a 
red eye, and PSE will automatically remove the red eye from the picture.  

 
 
The Healing Brush & Spot Healing Brush tools fix large and small areas of imperfections 
when you drag over them. For example, you can remove objects from a uniform background, 

such as an object in a field of grass or a speckle on a 
scanned old picture. 
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The Clone Tool is one of the more fun tools in PSE. It behaves 
like a brush, but instead of painting the foreground color it paints 
pixels from elsewhere in the image. Try out this tool on 
research.jpg. Set your source area by holding the Alt key and 

single-clicking on the person's hand. Then, elsewhere in the Image, just click and drag to paint. 
You will see that the balloon appears where you are painting. The clone tool is very effective in 
erasing things on human skin such as blemishes. Just set your source point to elsewhere on 
that person’s skin and paint over the offending area. The Pattern Stamp Tool works the same 
way, except with a pre-defined pattern. 

 
The Eraser Tool will clear out pixels unless they are on the 
bottom layer. In that case they are replaced with the background 
color. The Background Eraser Tool will only erase areas in the 
background. The Magic Eraser Tool works similar to the Magic 

Wand Tool, in that it makes selections to erase based roughly on color.  
 
 

The Brush Tool works just the way you would expect. Click 
and drag on your image to paint the foreground color. The 
size and shape of your brush can be adjusted in the Options 
Bar. Be sure to explore some of the presets (the dropdown 
found just to the left of size in the options bar) as there are 
some pretty neat brushes that include elements of 

randomness and color alterations. The Pencil Tool is just a specialized, 1 pixel width tool that 
operates the same as the Brush Tool. The Impressionist Brush Tool adds a swirl to brush 
strokes, and the Color Replacement Tool aids in replacing specific colors in an image.  
 

The Smart Brush Tools apply tonal and color adjustments to 
specific areas of the photo. The Smart Brush Tool makes 
a selection based on color and texture similarity. The Detail 
Smart Brush Tool lets you create an adjustment to specific 

areas of the photo. Both tools create adjustment layers. 
 

 
The Paint Bucket Tool works the same way as the magic wand, except that instead of 
selecting that area, it re-colors the area using your foreground color. You can find 

information on changing your foreground color in the Color Chips section of the tutorial. 
 
 

The Gradient Tool is used to apply a gradual change from one color to another. The 
application can often be more interesting in areas of flat color. Most of the time, you will 

want to use the Gradient Tool in conjunction with the selection tools. Just click and drag to fill 
your selection with a gradient. By default, the gradient is just foreground to background color 
and that's the recommended way to use it. You can create your own gradients by using the 
Options Bar. 
 
 

The Shape Tools let's you create shapes on your image, everything 
from squares and circles to word balloons and animal shapes. Click and 
drag to make the shape. Look in the Shape drop-down in the Options 
Bar to change your shape. 
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The Blur Tool will blur all the pixels below it. This is a good tool for 
softening seams when trying to combine two images. The Sharpen 
Tool will increase the contrast of the area clicked on. Do not try to 
use sharpen and blur as opposites. Also, this is a tool that is best 
used subtly. The Smudge Tool is used as if your photograph is a 

chalk drawing, and you just use your finger to push some of the chalk over. It is also effective for 
fixing seams from combined images. 
 

 
The Sponge Tool will pull the color and "life" out of a photograph. 
This a good tool for fixing areas that seem a little too intense. The 
Dodge Tool will lighten the area you click on; it is used similarly to 
the Sponge Tool, but slightly different. The Burn Tool is a tool that 
will darken an area and really bring out the shadows. The Burn Tool 

will help a scene look more dark and sinister, especially applied to the eyes of a person or 
animal.  
 
 

The Color Chips are used to determine your foreground and background color. In 
the picture to the left, the foreground is white and the background is maroon. Don't 
place too much significance on those names. Just know that some tools use 
foreground and others use background. To change you color, just click on the chip 

and use the resulting color picker to choose your color. The double-headed arrow can be used 
to swap the two. The little black/white at the left corner allows you to reset the color chips to the 
default setting. 
 
Layers  

 
Before we go any further, we need to discuss one of the 
most powerful features of Photoshop Elements. Layers 
give us the ability to combine different elements in a safe 
way, so that edits to any one element don't affect the 
other elements. Layers work similarly to overhead 
projectors. If you remember overhead projectors, you'll 
remember the clear sheets that you or your teacher used 
to draw on the overhead projector. Imagine laying two of 
those sheets on top of each other on the projector. On 
the screen, you would see a combination of both 
images, but in reality each image is separate and can be 
moved, altered or edited without affecting the other. This 
is the same way that layers work in Photoshop 
Elements.  
 
 
You will use the Layers Palette to control how the 
different layers interact with each other. 
 
Some tools automatically create new layers for themselves (shape and text being prime 
examples), but others do not. Generally, it is recommended to keep every discrete element of 
an image in its own layer. Also, take note that each layer can have its own set of properties 
including how visible it is (called opacity). 
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Layer Styles  
 
As mentioned earlier, each layer can have it own set of 
properties. Along with that, each layer can have its own set of 
special effects called Layer Styles. At this point, it should 
come as no surprise that Layer Styles are controlled by a 
palette that by default is found in the dock. 
 
There are many categories of Layer Styles all found in the 
dropdown menu. Think of Layer Styles as special effects that 
are added to your currently selected layer. These effects are 
dynamic as well, meaning that if your layer changes, your 
effect adjusts to match the layer. This is extremely useful on 
text, so that if you fix a typo, you don't have to reapply your 
glass button, for example. 
 
 
Saving Your Images 
 
Most of the images you will get from a digital camera will be in the .jpg format. This is because it 
yields the best picture for the smallest file size. However it is not the highest quality file format 
available. Most professional photographers use the .tiff format for photographs, as it can be 
entirely lossless, while .jpg includes some compression, and therefore some pixel data is lost. 
Also, it is important that if you do a large amount of touchup work that you keep a copy in the 
.PSD format as well. Otherwise, you will have to start over from the beginning to make even the 
smallest of changes. 
 
 
Additional Resources: 
 
Photoshop Elements Help in the Software 
http://help.adobe.com/en_US/PhotoshopElements/7.0_Win/ 
 
 
Photoshop Elements Online Support: 
http://www.adobe.com/support/photoshopelements/ 
 
 
Online Books Available Through JMU Libraries 
 
By clicking the links below on campus or with the JMU VPN client set up off campus, you will 
be able to view these electronic books in full text about Adobe Photoshop Elements 7. 
 

• Photoshop Elements 7 for Windows: Visual Quickstart Guide 

• Photoshop Elements 7: The Missing Manual, 1st Edition  

http://help.adobe.com/en_US/PhotoshopElements/7.0_Win/�
http://www.adobe.com/support/photoshopelements/�
http://proquestcombo.safaribooksonline.com/9780321606631�
http://proquestcombo.safaribooksonline.com/9780596521332�

